Spartan®-6 LX9 MicroBoard
Web Connectivity On Ramp Tutorial

Version 13.2.01
Revision History

<table>
<thead>
<tr>
<th>Version</th>
<th>Description</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>13.2.01</td>
<td>Initial release with support for ISE 13.2 tools</td>
<td>Aug. 10, 2011</td>
</tr>
</tbody>
</table>
Table of Contents

Revision History .............................................................................................................. 2
Table of Contents ............................................................................................................. 3
Table of Figures ............................................................................................................... 3
Table of Tables ............................................................................................................... 4
On Ramp Tutorial Overview .......................................................................................... 5
    S6 LX9 MicroBoard Web Connectivity On Ramp Tutorial Kit Requirements .......... 6
Programmable Configuration Setup ............................................................................. 8
Hardware Setup ............................................................................................................. 11
Compiling and Running the Software from SDK .......................................................... 14
    Specify the Workspace and the Hardware Platform ................................................. 14
    Import Software Projects ......................................................................................... 15
    Download the FPGA Configuration Bitstream File ............................................... 16
    Create a Run Configuration and Run the Application ............................................. 17
Network Setup ............................................................................................................. 18
USB to UART Serial Port Installation ........................................................................... 22
Appendix A: Troubleshooting ....................................................................................... 24
    Troubleshooting the Spartan-6 LX9 MicroBoard Serial Connection .................... 24
    Troubleshooting the Spartan-6 LX9 MicroBoard Network Connection ................. 26
Jumper Configuration ................................................................................................. 28
    Table 1 – S6 LX9 MicroBoard - Rev.B - Jumper Locations ..................................... 28
    Table 2 – Digilent PMODCon3 - Jumper Locations ................................................ 29
Getting Help and Support ......................................................................................... 30

Table of Figures

Figure 1 – MicroBoard configuration hardware ......................................................... 8
Figure 2 – Select Software on Digilent’s Webpage ..................................................... 9
Figure 3 – Download Serial Flash Utility ................................................................. 9
Figure 4 – Connect USB-JTAG programming interface to host PC ............................ 10
Figure 5 – SFUTIL Erase and Program script completed ......................................... 10
Figure 6 – Basic network configuration to host PC .................................................... 11
Figure 7 – Servo connection to MicroBoard through PMOD connector board ........... 12
Figure 8 – Basic network configuration to host PC .................................................... 12
Figure 9 – Alternate network configuration to host PC(s) ......................................... 13
Figure 10 – Alternate network configuration to wireless clients ............................... 13
Figure 11 – New Hardware Project Wizard ............................................................... 14
Figure 12 – Project Import Wizard ............................................................................ 15
Figure 13 – Project Import Wizard ............................................................................ 16
Figure 14 – Run Configurations control for target executables .................................. 17
Figure 15 – Network Connections .......................................................................... 18
Figure 16 – Local Area Connection Properties ....................................................... 19
Figure 17 – IP Settings ............................................................................................. 20
Figure 18 – Webpage displayed on Browser .............................................................. 21
Figure 19 – Debug output displayed in terminal ....................................................... 23
Figure 20 – Connecting the FPGA’s USB-UART ....................................................... 24
Figure 21 – USB-UART – Verifying COM port in Device Manager ............................ 25
Figure 22 – Connecting the FPGA’s USB-UART and Ethernet cable ....................... 26
Figure 23 – Recommended Ethernet adapter driver link speed settings .................... 27
Figure 24 – S6 LX9 MicroBoard - Rev.B - Jumper Locations ..................................... 28
Figure 25 – Digilent PMODCon3 - Jumper Locations ................................................ 29
Table of Tables

Table 1 – S6 LX9 MicroBoard - Rev.B - Jumper Locations ................................................................. 28
Table 2 – Digilent PMODCon3 - Jumper Locations ................................................................. 29
On Ramp Tutorial Overview

The Spartan-6 LX9 MicroBoard Web Connectivity On Ramp offers embedded and FPGA developers an example of how to:

1. Utilize lwIP for developing networked applications for embedded systems on Xilinx FPGAs without added overhead of an OS.

2. Provide software customized to run on Xilinx embedded systems containing a MicroBlaze™ processor.

3. Add application specific hardware peripherals to MicroBoard™ through use of PMOD expansion connectors.

4. Offload a timing critical task to customized FPGA hardware peripheral and attach to MicroBlaze™ PLB bus for control.

5. Use Xilinx SDK to create web server applications implementing a streamlined subset of the HTTP 1.1 protocol.

6. Provide Internet browser access to files residing on a Memory File System via HTTP GET commands.

7. Control and monitor servo position on the development board using XML data through AJAX HTTP requests.

8. Implement RAW mode TCP Web server through use of C callback functions to perform its tasks.
S6 LX9 MicroBoard Web Connectivity On Ramp Tutorial Kit Requirements

Hardware
The Web Connectivity On Ramp Tutorial requires the following hardware components:

- Avnet Spartan-6 LX9 MicroBoard Kit
  - Avnet Spartan-6 LX9 MicroBoard
  - USB Extension cable (if necessary)
  - USB A-to-MicroB cable
- Standard wired Ethernet patch cable
- Digilent PmodCON3 - R/C servo connector
- Digilent GWS Servo Kit
- Digilent COAXPOWER - Coax Power Cable
- Digilent SWPS - Switching Power Supply
- Recommended: Digilent JTAG HS1 Programming Cable or Xilinx JTAG Programming Cable.

Software
The Web Connectivity On Ramp Tutorial requires the following software:

- Internet Explorer V8.0+ OR Firefox V4.0+ Web Browsers
- Microsoft Windows XP or Windows 7
- Xilinx ISE WebPack with the SDK and ChipScope Pro add-ons version 13.2
  - Recommended: EDK add-on or Xilinx IDS Embedded Edition
- Installed Silicon Labs CP210x USB-to-UART Bridge Driver (see Silicon Labs CP210x USB-to-UART Setup Guide, listed in Recommended Reading, below)
- Terminal emulation application (such as HyperTerminal, Minicom, or Tera Term)
Recommended Reading

- An overview of the configuration options available on the Spartan-6 LX9 MicroBoard, as well as Digilent driver installation instructions can be found in the Avnet document, *Spartan-6 LX9 MicroBoard Configuration Guide*.
- Instructions on installing the Silicon Labs CP210x USB-to-UART drivers can be found in the Avnet document, *Silicon Labs CP210x USB-to-UART Setup Guide*.


- Details on the Spartan-6 FPGA family are included in the following Xilinx documents:
  - *Spartan-6 Family Overview* (DS160)
  - *Platform Studio Help* (available in tool menu)
  - *Platform Studio SDK Help* (available in tool menu)
Programmable Configuration Setup

This section describes how to program the configuration and application image into the SPI Flash for the Web Connectivity On Ramp Tutorial.

The following image illustrates the location of the connectors that will be used to program the hardware.

![MicroBoard configuration hardware](image)

Figure 1 – MicroBoard configuration hardware

The Digilent SFUTIL.exe utility provides a fast programming interface to the on-board serial flash and is included with the Web Connectivity On Ramp archive. The latest version of this utility can be downloaded from Digilent’s website. Once downloaded, this utility can be run from Windows command line or a batch file. Additionally this utility is customizable to perform a number of functions. To download the latest version of the SFUTIL.exe utility, follow the below instructions starting with Step 1 otherwise skip ahead to Step 4:

1. Open a Web Browser and navigate to Digilent’s website:

2. Click on **Software** link under the **Products** menu:

![Figure 2 – Select Software on Digilent’s Webpage](image)

3. Scroll down to Serial Flash Utility (SFUTILITY) and click **Download!**

![Figure 3 – Download Serial Flash Utility](image)

4. Save the Web Connectivity On Ramp Tutorial zip file and extract it to a known place on the host PC.
5. Connect the S6LX9 MicroBoard to the host PC as shown in Figure 4 by plugging it into an open USB port or by using the USB extension cable (Type A Male to Type A Female).

6. Locate the ‘Motor_Control_XPS_13_2_01\FLASH_BURN’ folder in the same directory the project files were extracted to. The ‘S6_LX9_EraseProgram_AVR_SF.bat’ script will be used to program the firmware MCS image file.

7. ‘S6_LX9_FPGA_Servo_Control_Firmware_V1_02.mcs’ to the SPI flash on the target MicroBoard.

8. Launch the batch file ‘S6_LX9_EraseProgram_AVR_SF.bat’ to execute the flash erase and programming process. **Note:** Programming times will vary based on FPGA Utilization as well as USB port speed.

![Figure 4 – Connect USB-JTAG programming interface to host PC](image)

![Figure 5 – SFUTIL Erase and Program script completed](image)
Hardware Setup

Although there are different ways that the network can be configured, the servo connections to the MicroBoard will not change between these different network configurations.

1. Connect the coax power adapter cable to the wall power supply.

2. Connect the black and white (or red depending upon your kit) pigtails to the power screw terminal connector J1 on the Digilent PMODCon3 board. The GND wire (black) should be connected to the negative terminal labeled with a `-` symbol.

3. Connect the servo connector to the 3 pin header P1 on the Digilent PMODCon3 board as seen in Figure 6. The GND wire (black) should be connected to pin 3 of the header and labeled GND.

4. Connect the Digilent PMODCon3 board connector J1 to the PMOD connector J4 on the Spartan-6 LX9 MicroBoard as shown in Figure 7. It is important to note that the Digilent connector P1 (pins P1-P6) must align with PMOD connector J4 (pins 7-12) using the row of pins nearest to the edge of the MicroBoard PCB.
The Basic Hardware setup should look like the one shown in Figure 8.

Figure 8 – Basic network configuration to host PC
An alternate setup could look like the one shown in Figure 9, this would allow different clients to be connected to the network. This configuration may also improve communications reliability with the Ethernet interface of the MicroBoard.

Another alternate setup could look like the one shown in Figure 10, this would allow wireless clients to be connected to the network through the use of a wireless router or access point.
Compiling and Running the Software from SDK

Following the instructions in the above section entitled Programmable Configuration Setup will allow the FPGA to configure and boot the tutorial application directly from the SPI flash. The reference design application can also be compiled and run using SDK with these tasks:

1. Open SDK in a new workspace and provide a reference to the hardware platform:
   `Motor_Control_XPS_13_2_01/SDK/SDK_Export/hw/system.xml`

2. Import the software platform and software applications for the target system.

3. Download the FPGA configuration bitstream file.

4. Create a run configuration and run the web server application.

Follow these same tasks to import and run any application using SDK. For more details regarding SDK concepts and tasks, see the online help in SDK.

Specify the Workspace and the Hardware Platform

The SDK Eclipse environment organizes projects within a folder called workspace. In SDK, a workspace can only contain projects for one specific hardware platform.

1. Unpack the reference design archive contents to `C:\Web_Controls_OnRamp`
2. Once SDK is started, specify a Workspace folder that will contain software projects for a particular hardware design `C:\Web_Controls_OnRamp`
3. The next step is to provide a reference to the hardware platform for which the software is being developed. This is done by pointing SDK to the hardware design specification file exported from XPS. Select File → New → Xilinx Hardware Platform Specification. Use the project name Servo_Control and specify the reference design hardware platform. The hardware platform specification is available in the folder: `C:\Web_Controls_OnRamp\Motor_Control_XPS_13_2_01\SDK\SDK_Export\hw`

![Figure 11 – New Hardware Project Wizard](image)
Import Software Projects

Software platforms and applications can be created in SDK after the hardware platform is specified. Instead of creating a new software platform/application, import the existing software platforms and example applications provided with this reference design using these steps:

1. Select **File** ➤ **Import** to open the import wizard.
2. Select **General/Existing Projects into Workspace** in the import wizard.
3. To select the root directory from which the projects need to be imported, click **Browse**, and specify the location where the software projects are stored. For this design, use the top level folder `C:\Web_Controls_OnRamp`
4. The import wizard displays a list of projects that are available to import. This list should include the `lwip_web_server_0`, `Servo_Control`, and `Servo_Control_Webserver` projects. Select the `lwip_web_server_0` and `Servo_Control_Webserver` projects to be imported, and select **Finish**

![Figure 12 – Project Import Wizard](image)

5. Select **Yes** if the SDK prompts to overwrite an existing project file.
Download the FPGA Configuration Bitstream File

Download the FPGA configuration bitstream file to the FPGA using these steps:

1. Select Xilinx Tools → Program FPGA to open the Program FPGA dialog.
2. Specify both the system.bit file and the system_bd.bmm file found in the Servo_Control folder, and then click Program.

Figure 13 – Project Import Wizard
Create a Run Configuration and Run the Application

To run the application, a run configuration must be created which specifies the ELF that needs to be run during execution. To create a new run configuration, follow these steps:

1. Select Run → Run Configurations
2. Select Xilinx C/C++ ELF and click New to create a new run configuration
3. Specify the ELF that needs to be run by selecting the `lwip_web_server.elf` file to run the web server example.
4. In the Run Configuration dialog, you can initialize the `image.mfs` file into memory by opening the Device Initialization tab, adding the `image.mfs` file from the , and specifying the load address of `0xBC800000`.

5. Click the Run button to begin running the executable on the MicroBlaze target processor.
Network Setup

The Web Connectivity On Ramp Tutorial design utilizes an embedded WebServer application. To access this application, you will need to configure the network properties on your PC. The following steps will guide you through this process.

1. Attach an standard Ethernet Cable between the MicroBoard and the PC.
2. Open Network Connections.
   Start → Control Panel
   Select Network Connections
3. Once open, right-click on Local Area Connection and select Properties:

![Network Connections]

Figure 15 – Network Connections
4. In Local Area Network Properties, Select Internet Protocol (TCP/IP), then click Properties.

![Local Area Connection Properties](image)

**Figure 16 – Local Area Connection Properties**
5. In the Properties Window, Select the Alternate Configuration tab. Click on 'User configured' and enter 192.168.1.5 for the IP address, 255.255.255.0 for the Subnet mask and 192.168.1.1 for the Default gateway:

![Internet Protocol (TCP/IP) Properties](image)

Figure 17 – IP Settings

6. Click OK.

7. Launch an internet browser, currently Firefox and Internet Explorer are supported.

8. Press SW4, PROG Button, on the MicroBoard.

9. Wait for the blue DONE LED to come on, the attached servo motor should set to the idle position while the application boots and finally rest in the '0' degree position once the application is running.
10. In the Internet Explorer V8.0+ OR Firefox V4.0+ Web Browsers, browse to the URL http://192.168.1.10/. The following webpage will open in the browser:

![Figure 18 – Webpage displayed on Browser](image-url)
USB to UART Serial Port Installation

The Web Connectivity On Ramp Tutorial requires a terminal emulation application for observing debug output from the application. You can use your preferred terminal application such as HyperTerminal or other application for this purpose. The following section contains instructions for installing and configuring the free for use Tera Term terminal emulation software. Tera Term can be downloaded free of charge from the SourceForge Japan site:

http://ttssh2.sourceforge.jp/

The following components were used for the installation instructions in this section and these components can be found in the \Terminal Software\ folder of the Web Connectivity On Ramp archive.

- TeraTerm Serial Terminal (teraterm-4.70.exe)
  - TERATERM.INI
- USB-Serial Drivers (CP210x_VCP_Win_XP_S2K3_Vista_7.exe)

Installation Instructions:

1) Install TeraTerm, using the provided executable:

   Terminal Software\teraterm-4.70.exe
   In the setup installer, select “Compact Installation”.

2) Install the CP210x Drivers, using the provided executable:

   Terminal Software\CP210x_VCP_Win_XP_S2K3_Vista_7.exe
   Take all of the defaults.

3) Copy the TERATERM.INI file to the Desktop

4) Start TeraTerm
   a. Do not attempt to start a new connection yet. Click “Cancel”.
   b. Go to “Setup” then “Restore Setup” and select the TERATERM.INI file on the Desktop
      i. This automatically sets the serial port settings
         (115200, 8, n, 1, no flow control)
5) Test the installation by plugging in a board and powering it on
   a. The USB drivers should be located automatically.
      Wait a few seconds after the drivers have installed.
   b. In TeraTerm, go to the “File” then “New Connection”. This will open a dialog.
      i. “Serial” should be selected. There will probably be a “COM10: Silicon Labs CP210x USB to UART Bridge (COM10)” in the drop down list of COM ports. Select it.
      ii. Hit OK
   c. Reset the Spartan-6 LX9 MicroBoard board by pressing the SW4, PROG Button.
   d. You should immediately see text appear on the screen.

Figure 19 – Debug output displayed in terminal
Appendix A: Troubleshooting

This section provides troubleshooting information for the S6 LX9 MicroBoard Web Connectivity On Ramp Tutorial setup.

Troubleshooting the Spartan-6 LX9 MicroBoard Serial Connection

Make sure that you have a USB-A to micro-B cable connected between the PC and the Spartan-6 LX9 MicroBoard Kit’s J3 connector, as shown below.

![Diagram of Spartan-6 LX9 MicroBoard]

Figure 20 – Connecting the FPGA’s USB-UART

When the serial link between the MicroBoard Kit and the PC is active, the D6 LED close to the connector will light up. This will occur after the board has been powered on, and once the USB UART device drivers are installed.
You should check the Device Manager on your host PC to verify the Com port used, as you may need to modify the HyperTerminal shortcut supplied to match this host specific value. Follow these steps:

- In Windows Explorer, right-click on My Computer and select Manage.
- Select Device Manager in the left panel.
- Select Ports (COM & LPT) in the right panel. The CP210x USB to UART bridge should indicate the Com port selected. In the case of this example, it is COM6. You should write this down for future reference, and keep in mind that it might change if you reboot your computer.

![Figure 21 – USB-UART – Verifying COM port in Device Manager](image)

Make note of the COM port number, as this is the one you must use to configure your terminal emulator application.
Troubleshooting the Spartan-6 LX9 MicroBoard Network Connection

The basic network configuration for the Spartan-6 LX9 MicroBoard Web Connectivity On Ramp Tutorial is shown below:

![Diagram showing network connections](image)

Figure 22 – Connecting the FPGA’s USB-UART and Ethernet cable

Make sure that Ethernet adapter on host PC Windows is configured as follows:
- IP = 192.168.1.5
- Gateway = 192.168.1.1

Make sure your laptop’s wireless internet is disabled otherwise there may be a routing conflict that prevents the MicroBlaze host from being reached.
Also, if you are using a Gigabit Ethernet port on the host PC, there may be an auto-negotiation issue that results in very poor network performance when transferring data between the PC and the Spartan-6 LX9 MicroBoard. You can get around this by either using an intermediary switch between the PC and the MicroBoard (as shown in Figure 9) or forcing the PC adapter to negotiate to a lower speed (as shown in Figure 23 below). A recommended setting that generally works well is **100 Mbps Half Duplex**.

![Network Connections](image)

**Figure 23 – Recommended Ethernet adapter driver link speed settings**
Jumper Configuration

The jumper locations and configurations for Rev.B of the S6 LX9 MicroBoard are described by Error! Reference source not found.4 and Error! Reference source not found.1.

Figure 24 – S6 LX9 MicroBoard - Rev.B - Jumper Locations

<table>
<thead>
<tr>
<th>Jumper</th>
<th>Position</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>J2</td>
<td>open</td>
<td>Boot Program Enable</td>
</tr>
</tbody>
</table>

Table 1 – S6 LX9 MicroBoard - Rev.B - Jumper Locations
The jumper locations and configurations for the Digilent PMODCon3 board are described by Error! Reference source not found.5 and Error! Reference source not found.2.

Figure 25 – Digilent PMODCon3 - Jumper Locations

<table>
<thead>
<tr>
<th>Jumper</th>
<th>Position</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>JP1</td>
<td>VS-VE</td>
<td>Vsupply - Connects External Voltage Supply For Motor Power</td>
</tr>
</tbody>
</table>

Table 2 – Digilent PMODCon3 - Jumper Locations
Getting Help and Support

Evaluation Kit home page with Documentation and Reference Designs:

http://em.avnet.com/s6microboard

Avnet Spartan-6 LX9 MicroBoard forum:


Digilent webpage: The Digital Design Engineer's Source - Evaluation boards, reference designs and Kits:

http://www.digilentinc.com/

For Xilinx technical support, you may contact your local Avnet/Silica FAE or Xilinx Online Technical Support at www.support.xilinx.com. On this site you will also find the following resources for assistance:

- Software, IP, and Documentation Updates
- Access to Technical Support Web Tools
- Searchable Answer Database with Over 4,000 Solutions
- User Forums
- Training - Select instructor-led classes and recorded e-learning options

Contact Avnet Support for any questions regarding the Spartan-6 LX9 MicroBoard reference designs, kit hardware, or if you are interested in designing any of the kit devices into your next design.

http://www.em.avnet.com/techsupport

You can also contact your local Avnet/Silica FAE.